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Unit 4 Word Processing, Desktop Publishing, and 
Document Formatting 

Chapter Review Activities 

Note that activities provided at the end of each chapter in this unit will help students: 

• Review the concepts they have learned; 

• Apply the software skills they have learned; 

• Improve their keyboarding skills; 

• Learn about business trends and issues; 

• Improve math and communication skills; 

• Develop career-related skills. 

Chapter 9 Reports and Outlines 

Chapter Objectives 

Discuss the Chapter 9 objectives with students:  

• Enter, edit, and format text using Microsoft Word. 

• Create reports in MLA format. 

• Create report outlines and citations. 

• Create reports in a standard format. 

Web Resources 

Review the activities for Chapter 9 that are found on the Web site. Decide whether you 

wish to have students complete the games and activities. 

• Data Files 

• Vocabulary Flash Cards  

• Beat the Clock, Reports  

• PowerPoint Reviews 

• More Activities 

o Chapter 9 Supplemental Activity, Research Citing References in an MLA Report 

o Chapter 9 Supplemental Activity, Report in MLA Format 

 

Slides 

Preview the PowerPoint slides for Chapter 9 found on the IRCD. Decide which ones you 

will use for your presentations and demonstrations. 

 

Assessment 

ExamView test for Chapter 9    
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Lesson 66 MLA Reports  

Lesson Objectives  

Discuss the Lesson 66 objectives with students:  

• Learn to select text 

• Learn features in the Paragraph group in the Home tab. 

• Learn features in the Font group in the Home tab. 

• Learn features in the Header & Footer group in the Insert tab. 

• Arrange a short report in MLA format. 

Data Files 

• DF 66A Report 

• DF 66A Select 

• DF 66B Report 

• DF 66C Font 

• DF 66D Report 

Software Features 

The following software features are introduced in Lesson 66: 

 

• Line Spacing 

• Select Text 

• Paragraph Alignment 

• Fonts 

• Headers and Footers 

Document Formats 

The following document format is introduced in Lesson 66: 

 

• Report in MLA format. 

Vocabulary Terms 

The vocabulary terms from Lesson 66 and their definitions are listed below. Explain the 

meaning of these words to students as you discuss the appropriate sections of the lesson.  

 

report  A document that gives facts, ideas, or opinions about one 

or more topics 

format 

 

To place text on a page so it looks good and is easy to 

read 

Line Spacing Word feature used to change the amount of blank space 

between lines of text 

paragraph  Any amount of text that is keyed before the ENTER key is 

struck; can be one word or several words or lines 

Align Left   Starts all lines of the paragraph at the left margin; is the 
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default paragraph alignment  

Align Right Ends all lines at the right margin 

Center Places an equal (or nearly equal) space between the text 

and each side margin 

Justify Starts all lines at the left margin and ends all full lines at 

the right margin 

header Contains information that appears at the top of pages in a 

document 

footer  Contains information that appears at the bottom of pages 

in a document 

 

Teaching Strategies 

Refer to the teaching notes in the Century 21 Jr., Annotated Teacher’s Edition for each 

section and activity listed below. 

 

1. Have students read Lesson 66. 

2. Discuss the Line Spacing and Select Text sections with students. Have them complete 

activity 66A Learn: Line Spacing and Select Text. Make the data files needed for this 

activity available to students. 

3. Discuss the Paragraph Alignment section with students. Have them complete activity 

66B Learn: Paragraph Alignment. Make the data files needed for this activity 

available to students. 

4. Discuss the Fonts section with students. Have them complete activity 66C Learn: 

Change Fonts and Font Formats. Make the data files needed for this activity 

available to students. 

5. Discuss the Headers and Footers section with students. Have them complete activity 

66D Learn: Header with Page Number and activity 66E Learn: Footer. Make the 

data files needed for activity 66D available to students. 

6. Discuss the MLA Reports section with students. Have them complete the activities in 

this order: 

66F Learn: Format an MLA Report 

66G Apply: Compose an MLA Report 

Lesson 67 Outlines and MLA Reports with Citations 

Lesson Objectives  

Discuss the Lesson 67 objectives with students:  

• Create an outline. 

• Create an MLA report with textual citations and a Works Cited page. 

• Learn features in the Citations & Bibliography group. 

• Learn Bullets and Numbering in the Paragraph group. 
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Data Files 

• DF 67B Report 

• DF 67D Outline 

• DF 67E Indents 

• DF 67G Sources 

Software Features 

The following software features are introduced in Lesson 67: 

 

• Bullets and Numbering 

• Increase Indent and Decrease Indent 

• Numbering or Multilevel List 

• Numbered List 

• Indents and Spacing; Hanging Indent 

• Page Breaks 

• Citations and Bibliography 

Document Formats 

• Outline for report. 

• In-text citations and Works Cited page for MLA style.  

Vocabulary Terms 

The vocabulary terms from Lesson 67 and their definitions are listed below. Explain the 

meaning of these words to students as you discuss the appropriate sections of the lesson.  

 

bullets   Characters or graphics that appear before each item in a 

list 

outline  A document that gives the main points of a subject 

hanging indent  Format that begins all lines except the first line away 

from the left margin 

page break   Signals the end of a page 

citations  Notes that are placed in the body of an MLA report to 

mark material taken from other sources 

 

Teaching Strategies 

Refer to the teaching notes in the Century 21 Jr., Annotated Teacher’s Edition for each 

section and activity listed below. 

 

1. Have students read Lesson 67. 

2. Discuss the Bulleted and Numbered Lists section with students. Have them complete 

activity 67A Learn: Bulleted and Numbered Lists and activity 67B Practice: MLA 

Report with Bulleted List. Make the data files needed for activity 67B available to 

students. 
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3. Discuss the Outlines section with students. Have them complete activity 67C Learn: 

Outline Using Numbered List Feature and activity 67D Practice: Outline Using 

Numbered List Feature. Make the data files needed for activity 67D available to 

students. 

4. Discuss the Paragraph Indents section with students. Have them complete activity 

67E Learn: Paragraph Indents. Make the data files needed for this activity available 

to students. 

5. Discuss the Manual Page Breaks section with students. Have them complete activity 

67F Learn: Manual Page Breaks.  

6. Discuss the Works Cited section with students. Have them complete activity 67G 

Practice: Indents and Manual Page Breaks and activity 67H Apply: MLA Report with 

Works Cited. Make the data files needed for activity 67G available to students. 

Students will need Internet access to complete activity 67H. 

Lesson 68 Reports in Standard, Unbound Format 

Lesson Objectives  

Discuss the Lesson 68 objectives with students:  

• Learn the Spelling and Grammar feature. 

• Learn different page numbering positions and the Different First Page feature. 

• Learn the Styles feature. 

• Arrange unbound reports using a standard format.  

Data Files 

• DF 68A Report  

• DF 68D Report 

Software Features 

The following software features are introduced in Lesson 68: 

 

• Spelling & Grammar 

• Page Number and Different First Page 

• Styles 

Document Formats 

The following document formats are introduced in Lesson 68: 

 

• Report in standard format 

Vocabulary Terms 

The vocabulary terms from Lesson 68 and their definitions are listed below. Explain the 

meaning of these words to students as you discuss the appropriate sections of the lesson.  

 

style  A collection of format settings for font, font size, color, 
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paragraph spacing, alignment, and so on 

unbound report A short report prepared without a cover or binder 

standard format The typical format used for an unbound report 

Teaching Strategies 

Refer to the teaching notes in the Century 21 Jr., Annotated Teacher’s Edition for each 

section and activity listed below. 

 

1. Have students read Lesson 68. 

2. Discuss the Spelling & Grammar section with students. Have students complete 

activity 68A Learn: Spelling & Grammar Feature. Make the data files needed for this 

activity available to students. 

3. Discuss the Page Numbers and Different First Page section with students. Have 

students complete activity 68B Learn: Page Numbering Positions and Different First 

Page Feature.  

4. Discuss the Styles section with students. Have them complete activity 68C Learn: 

Styles.  

5. Discuss the Standard, Unbound Reports section with students. Have them complete 

the activities in this order: 

68D Learn: Standard, Unbound Report 

68E Apply: Standard, Unbound Report with References 

Make the data files needed for activity 68D available to students. Students will need 

Internet access to complete activity 68E. 

 

Lesson 69 Reports  

Lesson Objectives  

Discuss the Lesson 69 objectives with students:  

• Learn and use proofreaders’ marks. 

• Format standard, unbound reports and MLA-style reports. 

Data File 

• DF 69B Report 

Software Features 

The following software features are introduced in Lesson 69: 

 

• Citations and Bibliography 

Document Formats 

No document formats are taught in this lesson. 
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Vocabulary Terms 

The vocabulary term from Lesson 69 and its definition is listed below. Explain the 

meaning of this word to students as you discuss the appropriate sections of the lesson.  

 

proofreaders’ marks Letters and symbols used to show errors in a document 

Teaching Strategies 

Refer to the teaching notes in the Century 21 Jr., Annotated Teacher’s Edition for each 

section and activity listed below. 

 

1. Have students read Lesson 69. 

2. Discuss the Proofreaders’ Marks section with students. Have students complete the 

activities in this order: 

69A Learn: Proofreaders’ Marks 

69B Apply: MLA Report with Proofreaders’ Marks 

69C Apply: Unbound Report with Proofreaders’ Marks 

Make the data files needed for activity 69B available to students.  

Chapter Review 

Data Files 

• DF C09 Report1 

• DF C09 Report2 

• DF C09 Report3 

• DF C09 Numbers 

• DF C09 Table 

• DF C09 Business 

• DF C09 Science 

• DF C09 Science and Math 

Vocabulary Terms 

The vocabulary terms from the Across the Curriculum activities and their definitions are 

listed below. Explain the meaning of these words to students as you discuss the 

appropriate sections. 

 

fixed costs Expenses that remain the same regardless of the amount 

of services or goods that are produced or sold 

variable costs Expenses that change depending on the amount of 

services or goods that are produced or sold 

marginal cost The amount that total cost changes as the amount of 

goods or services produced changes 
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Teaching Strategies 

Refer to the teaching notes in the Century 21 Jr., Annotated Teacher’s Edition for each 

section and activity listed below. 

 

1. Have students complete the Reviewing What You Have Learned questions.  

2. Have students complete the activity Report in Standard, Unbound Format. Make the 

data file needed for this activity available to students. 

3. Have students complete the activity Report in MLA Format. Make the data file 

needed for this activity available to students. 

4. Have students complete the second Report in Standard, Unbound Format activity. 

Make the data file needed for this activity available to students. 

5. Have students complete the activity Outline for Report.  

6. Have students complete the activities in Keyboarding Skillbuilding. 

7. Discuss the Academic Connections, Communications: Number Usage and Reading: 

Read a Table  sections with students. Have students follow the steps provided to 

complete the activities. Make the data files needed for these activities available to 

students. 

8. Discuss the About Business, Fixed and Variable Costs section with students. Have 

them follow the steps provided to complete the activity. Make the data files needed 

for these activities available to students. 

9. Discuss the Life Success Builder, Science and Math vs. Your Career section with 

students. Have them follow the steps provided to complete the activity. Make the data 

files needed for these activities available to students. 

10. Discuss the Career Exploration Portfolio activity with students. Have students follow 

the steps provided to complete the activity. Students need access to the Internet to 

complete this activity. Students will work with a classmate to complete this activity. 


